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Overview

QRead lets you read text files quickly and easily in the Microsoft Windows 3.1 environment. 
Text files can be shown on the screen in any font you choose, and QRead will automatically 
adjust the type size or the line structure to fit the window. The display changes, but not the file 
itself. QRead accesses your file in a "read only" manner.    

QRead supports the drag-and-drop feature. This means that you can "drag" a file name displayed 
in the File Manager window to the QRead icon (or window). When you "drop" the file name into
QRead, the file will be immediately displayed.

Qread also provides tools to help with browsing and management of your text files. You can 
filter out non-alphanumeric characters, search for a text string, place a bookmark, and copy 
information to the clipboard. You can also print and delete files from within QRead. The 
Entry/Exit behavior and the display settings of QRead can be customized and remembered on a 
file-by-file basis.



Installation And Quick Start

The simplest installation of QRead consists of one step - copy the file qread.exe to your disk. No 
other files are necessary to get started.

The first time you enter QRead it will use default settings. The first time you exit QRead it will 
save the environment that you have in place at the time of exit. This environment is stored in the 
file "qread.ini" in your windows directory. Unless you choose to store settings information, 
qread.ini will be the only file that QRead writes to your disk. (The sections on the Entry / Exit 
menu item and the Store menu items explain how QRead stores settings information.) 

If you want to be able to use on-line Help, you must also copy the file qread.hlp to your windows
directory. 

To install QRead as a program item (using icons, etc.), refer to the section on Windows Program 
Manager.



Deinstallation

If you want to deinstall QRead, follow these steps. First, delete qread.exe from the directory 
where it "lives." Next, delete qread.ini, qread.cus, qread.hlp from your windows directory. 
Finally, delete all the ".qfs" files you or QRead have created.



Licensing And Distribution

QRead is a Shareware program and is provided at no charge to the user for EVALUATION. All 
rights are retained by the author. Feel free to share this program with your friends, but please do 
not give it away altered or as part of another system. If you try a Shareware program and then 
continue to use it, you are expected to register and become a licensed user.

If you are using QRead after a reasonable evaluation period (30 days), send your name, address 
and the license fee of $20 to:

        DS Products
        P.O. Box 342
        Westford, MA    01886

The $20 fee will license one copy for use on any one computer at any one time. You must treat 
the licensed software just like a book.    An example is that this software may be used by any 
number of people and may be freely moved from one computer location to another, so long as 
there is no possibility of it being used at one location while it's being used at another, just as a 
book cannot be read by two different persons at the same time. Site License arrangements may 
be made by contacting DS Products.

Registered users will receive:
        support (via CompuServe [70731,1673] or regular mail),
        minor upgrades at NO charge,
        major upgrades at a reduced price,
        a key that disables the registration reminder window, and
        a clear conscience.

Anyone distributing QRead for any kind of remuneration must first contact DS Products at the 
address below for authorization. This authorization will be automatically granted to distributors 
recognized by the ASP as adhering to its guidelines for shareware distributors, and such 
distributors may begin offering QRead immediately. DS Products must still be advised, however,
so that the distributor can be kept up to date with the latest version of QRead.

The essence of Shareware is to provide users with quality software without high prices, and yet 
to provide incentive for programmers to continue to develop new products. Shareware is a 
distribution method that allows you to try before you buy. Shareware has the ultimate money 
back guarantee -- if you don't use the product, you don't pay for it.



Disclaimer

Users of QRead must accept this disclaimer of warranty: "QRead is supplied as is.    The author 
disclaims all warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose. The author assumes no liability for damages, 
direct or consequential, which may result from the use of QRead."



ASP Ombudsman

QRead is produced by a member of the Association of Shareware Professionals (ASP). ASP 
wants to make sure that the shareware principle works for you. If you are unable to resolve a 
shareware-related problem with an ASP member by contacting the member directly, ASP may be 
able to help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP 
member, but does not provide technical support for members' products. Please write to the ASP 
Ombudsman at 545 Grover Road, Muskegon, MI 49442 or send a CompuServe message via 
CompuServe Mail to ASP Ombudsman 70007,3536.



Open

When you select a file using the Open dialog box, QRead attempts to open the file and copy the 
entire file into memory. QRead uses this memory image to format and display the "open" file. No
changes are ever made to the file on disk. Technical note: After the copy has been made, Qread 
actually closes the file. That is, the file is immediately closed as far as the operating system is 
concerned. 

QRead places no limit on file size ("huge" pointers are used). Of course, the open command will 
fail if you do not have enough memory available.

Only one file is open at a time. If you ask to open a new file when there is already a file open, the
new file is copied into memory replacing the memory image of the previously open file.

Whenever QRead opens a file, it checks to see if there is a file with the same name and path 
name but with the ".qfs" extension. If there is, QRead will read the stored settings info from 
the .qfs file and update the settings.



Open (continuous)

This menu item performs the same function as Open, but continues to display the dialog box 
after the Open command has completed. This is useful if you want to quickly browse through 
many files. It is also useful in conjunction with Delete. That is, you can quickly open a file, 
delete it if necessary, and then open the next file.



Close

Close "erases" the file from memory - it gives back the memory to Windows.

There is another effect of close. When you invoke the close menu item, the current settings will 
be stored in the ".qfs" file, if you have checked "On close and exit, store settings for file" in the 
Entry/Exit dialog box. 

Scroll bars and some menu items are disabled if there is no file open.



ReOpen

This menu item is equivalent to Open <filename> where <filename> happens to be the name of 
the file that is currently displayed. The file is read into memory, the view pointer is positioned to 
the beginning of the file, and the settings are reset to the values stored in the associated ".qfs" file
(if one exists). 

If you modify the settings and then change your mind, ReOpen gets you back to the original 
state.    If you launch an editor from QRead and modify the file itself, ReOpen gets the new 
version of the file into QRead.



Delete the open file

Delete asks you to confirm that you "really want to do this" before deleting the open file. If you 
are pretty sure already, for example when you are browsing through files, you can speed up the 
delete process by using the hotkey "Delete" and then "Enter" to confirm the deletion.



Print

The Print dialog box allows you to print the contents of the current window, or the entire file. 
When you chose the current window, QRead assumes you want to print the window text using 
the current view (as shown on the display). The As saved, and With adjusted lines radio buttons 
are grayed, but they do reflect the current view mode. When you chose to print the entire file, 
then you can chose either As saved or With adjusted lines. 

If you choose to print with the displayed font, QRead will ask Windows to use that font when 
printing. If that font is not usable, the Windows font mapper will substitute for that font. Use 
TrueType fonts to ensure compatibility.    The margin dimensions (such as "1/2 inch") are 
approximate.

Form Feed characters embedded in the file will cause a page to be ejected from the printer.



Printer Setup

This menu item calls up the standard Printer Setup dialog box which allows you to select the 
printer you want to use.



Exit

When you exit QRead, if you have a file open, AND if you have checked "On close and exit, 
store settings for file" in the Entry/Exit dialog box, the current settings will be stored in the ".qfs"
file.



As saved

QRead offers three views of your file - As saved, With adjusted type, With adjusted lines. Only 
one of the three views can be selected at a time, but you can switch between the views at any 
time. When you switch, your position in the file is preserved. You will find the same first 
character displayed in the upper left corner of the window.

The As saved view displays the text file in the standard way, using the embedded new line 
characters to separate lines of text, but with the power of "fancy fonts." If a line is too long to fit 
in the given window with the given font, you have three choices: resize the window, change the 
font, or use the horizontal scroll bar (provided only in this view).

This view is good for viewing formatted text, like poetry or computer program listings. Don't 
forget to select a fixed pitch font, like Courier, to keep the formatting exact. If your text is mostly
unformatted, but has occasional formatting using tab or space characters, try the "With adjusted 
lines" view.



 With adjusted type

QRead offers three views of your file - As saved, With adjusted type, With adjusted lines. Only 
one of the three views can be selected at a time, but you can switch between the views at any 
time. When you switch, your position in the file is preserved. You will find the same first 
character displayed in the upper left corner of the window.

The With adjusted type view displays the text as large as possible in the given window. That is, 
QRead automatically adjusts the type size to display the longest line in the largest type possible, 
within the limits of the chosen typeface. This view is good if you like things big.

The type size calculated may change when the window is resized OR when the longest line 
changes. As you scroll through a document, therefore, the type size may change. If this effect 
annoys you, you may want to use the adjusted type view to set a type size when you first open a 
file, and then switch to one of the other views to lock in that type size.



With adjusted lines

QRead offers three views of your file - As saved, With adjusted type, With adjusted lines. Only 
one of the three views can be selected at a time, but you can switch between the views at any 
time. When you switch, your position in the file is preserved. You will find the same first 
character displayed in the upper left corner of the window.

The With adjusted lines view holds the type size constant and reformats the lines of text to fill 
the window. Remember that the reformatting occurs only in QRead's memory, and that no 
changes are made to your text file on disk. This view is good for reading books and articles in the
large type sizes without having to use large windows.

QRead fills lines one word at a time, using the space character (usually) to determine the end of a
word. Qread will stop filling a line if it finds a blank line, a line that begins with a space, or a line
containing a tab.    The reformatting will preserve the paragraph structure of your text file, 
therefore, if a new paragraph is denoted by a blank line, a line indented with spaces, or a line 
indented with a tab character. Lines containing a tab character are a special case.

When QRead finds a line (in the text file) containing one or more tab characters, it displays that 
line exactly AS STORED. The rationale is that someone put tabs in the text file for formatting 
purposes (perhaps for a table), and so QRead should try to preserve the format even if it means 
that a line might get clipped EVEN IN THIS ADJUSTED LINES VIEW.

The result of the algorithms described above is that QRead should handle most text files and 
preserve their paragraph structure and tables. If you are creating a text file to be read in QRead 
adjusted lines view, use blank lines or lines indented with spaces to denote paragraphs. Save the 
tabs for your tables.

Trivia note: QRead reformatting occurs on a page by page basis; the whole file is not reformatted
at once. This causes one effect that you may find surprising. When scrolling backward, QRead 
may not choose the same word to begin a line as it did when you were scrolling forward. Don't 
worry, no words are lost. 



Increase type size

Choosing this menu item will increase the type size, UNLESS you are in the "With adjusted 
type" view. You can use the numeric key pad "+" to pump up your type size.



Decrease type size

Choosing this menu item will decrease the type size, UNLESS you are in the "With adjusted 
type" view. You can use the numeric key pad "-" to shrink your type size.



Hide low characters

Low order characters (from 0x00 to 0x19) are often called "control characters." These characters 
control the operation of the receiving device, but are not usually displayed or printed. Examples 
of characters in this range are Carriage Return(CR) and Start of Text (STX). Depending on the 
font, QRead will display them as peculiar looking symbols (such as musical notes or boxes), 
unless this menu item is enabled.

If you do not want to see these characters, enable this menu item and QRead will replace each 
one with a blank, or SPACE character. This feature can be useful in viewing files created for 
word processors or hypertext reader programs. Blanking out these characters may make the file 
more readable.

For more information, see the section on special characters.



Hide high characters

High order characters (from 0x7F to 0xFF) are often called "extended characters." They are 
"extensions" to the alphanumeric character set. Examples of characters in this range are line 
drawing symbols or international characters (such as vowels with the umlaut symbol). QRead 
will display them, unless this menu item is enabled.

If you do not want to see these characters, enable this menu item and QRead will replace each 
one with a blank, or SPACE character. This feature can be useful in viewing files created for 
word processors or hypertext reader programs. Blanking out these characters may make the file 
more readable.

For more information, see the section on special characters.



Repaint

If the display ever looks bogus, try a repaint.



Find

Find always starts its search from the current character position which, in case you didn't know, 
is the character displayed in the upper left corner of the window. The search string is limited to 
25 characters. 

If the search string is found, QRead moves the current character position to show the found text 
at or near the first line, and highlights the found string. The highlighting remains on until there 
has been an unsuccessful search AND the display has been repainted. 



Find Next

The Find Next menu item is disabled until you have successfully used Find. The Find Next 
search starts just after (or just before) the last successful Find.



Copy to clipboard

The clipboard provides a way to get data out of QRead. This menu item copies the contents of 
the window to the clipboard AS TEXT. The text is copied from the memory image of the file, so 
the formatting of the clipboard text will match the formatting of the original file. (Remember that
if you are in the "With adjusted lines" view, the image you are viewing has been reformatted.) 
You can then paste the clipboard text into a receiving program for further processing, such as 
printing.

You can also use the Windows provided copy to clipboard functions (using PrintScreen or 
Alt+PrintScreen) to copy QRead data AS GRAPHICS. You can then paste the clipboard graphics
into a receiving graphics program, such as a paint program. 



Place bookmark

There is only one bookmark and you use this menu item to place it just before the current 
character position (the character at the upper left of the window). Once you move away from the 
current character position, the bookmark disappears, but it is remembered and will be displayed 
if you choose the "Go to bookmark" menu item.

The bookmark can be remembered in a ".qfs" file. Refer to the "Store settings for file" menu 
item.



Remove bookmark

If you tire of having a bookmark and you just can't stand the thought of having it around, use this
menu item.



Go to bookmark

This menu item moves to the bookmark and displays the bookmark at the top of the window. 
Trivia note: If you experiment with control panel and change your window colors you will find 
that the bookmark is not always the same color as the highlighted text used to show the search 
string.



Launch another QRead

Choosing this menu item will launch another instance of QRead (which might be used to read 
another file). The new instance will start up using qread.ini, so its window may not look exactly 
like the one that preceded it.



Launch companion App

This menu item will launch an application to be used in conjunction with QRead. For example, 
you can use QRead to browse through a file and then launch an editor to change the file.

The default application is the Windows editor, Notepad. Notepad will be launched with the file 
name of the open file as an argument. 

You can change the application that will be launched, but you must edit your qread.ini file to do 
so. Insert a line in qread.ini to specify the application. For example, to launch the application 
"yourapp" with the open file name as an argument, you would add the following line to qread.ini:

App1=yourapp %FileName%

Note: The test for %FileName% is case sensitive.



Fonts

Qread asks Windows for the names of all your installed fonts and displays those names in the 
Fonts dialog box. When you select a font (by clicking on OK or double clicking on one of the list
boxes) QRead finds the available sizes. If the font is scalable, QRead uses a list of sizes from 8 
to 24 points. QRead then asks the Windows font mapper for a font with the selected name, 
selected size, and Regular style. The result is a new, beautifully formatted display with the font 
you selected, usually.

The font mapper will return substitutes for certain decorative fonts. As a design decision to keep 
QRead lean and mean, a minimum of font information is stored, and that results in the 
elimination of a small number (I hope) of fonts. Let me know what you think.



Tabs

Since QRead has no idea where the tabs were set when the text file was created, the Tabs dialog 
box allows you to recreate the settings.    The tabs can be set to divide the page into columns (as 
might be useful for tables), or they can be set every N character positions (as might be useful for 
a computer program listing).



Entry / Exit

This command brings up the Entry/Exit dialog box. The settings here control the entry and exit 
behavior of QRead. You can choose from the common option groups by using the right half of 
the dialog box, or "roll your own" group by changing the individual options on the left side.

The Entry / Exit dialog box should perhaps be marked "handle with care." Since these settings 
control the entry behavior of the program, if you forget what you asked for here, you can get 
totally confused about QRead's behavior. 

For example, if you normally use QRead in the "Memory-less" mode, QRead will come up with 
the default settings and it will not open any files. But if you forget that you checked "Remember 
last" the last time you used QRead, you could get confused as to why your font, tabs, or even 
view mode are different from what they normally are.

If you normally use the "Remember last" mode, you expect that on entry QRead will be as it was
when you left it. But if you are opening a file that has a ".qfs" file, don't forget that the stored 
settings in the .qfs file will override your last settings.

The "Remember many" mode is useful if you use Qread to work with lots of files and you like to
customize the display of each file. But try not to be surprised when you find .qfs files all over 
your disk. You might even say, "I don't remember creating that file" and you would be right. 
QRead did! To avoid creating lots of small files, use the "store settings for file" item on the 
Options menu only when you need it.

I recommend choosing your favorite mode of operation for QRead and then minimizing your use
of the Entry/Exit menu item. If you do get confused, you can always retrieve default settings, and
custom settings from the Options menu.



Registration info

The Registration info dialog box allows you to enter your name and the key that you receive 
upon registration. The information will be written to the qread.ini file. The next time you enter 
QRead with this info in the qread.ini file, you will bypass the registration reminder.

To Register, print out the registration form (open the file REGISTER.TXT in the QRead 
distribution archive), fill out the form, and send in the form with your payment. If you do not 
have REGISTER.TXT, forget the form, and just send in your registration fee to the address 
shown in the About dialog box.

Once you receive your registration letter, save it in a safe place. If the qread.ini file gets 
corrupted or deleted, you will have to reenter your registration info.



Keep icon on top

When this menu item is enabled, the QRead icon will appear on the top of the pile of windows 
on your "virtual desktop" (your screen). This makes it easier to find in general, but it is 
particularly useful in conjunction with the drag-and-drop feature. You can make the File 
Manager window as large as you want, even full screen, since the QRead icon will still be 
visible.

When the QRead window is normal (non-iconized) it will not try to stay on top.



Load default settings

Choose this menu time to revert to the default settings. The settings affected are: View mode, 
Hide mode, Font, Tabs, and IconOnTop settings. The bookmark is not affected.



Load custom settings

If you have previously stored custom settings, you created a qread.cus file in your windows 
directory. This menu item loads the stored custom settings from that file. The settings affected 
are: View mode, Hide mode, Font, Tabs, and IconOnTop settings. The bookmark is not affected. 



Store custom settings

You can customize QRead by setting up your preferred environment and then choosing this menu
item to store the settings. You can then use the Entry/Exit menu item to arrange for loading of the
custom settings, rather than the default settings, on entry to QRead.

The default settings are good for unformatted text files, such as articles or books, so you might 
want to set up the custom settings for formatted files, such as poetry or computer program 
listings. Then you could use the hotkeys for default and custom settings when switching between
the two types of files.

The custom settings are stored in the file qread.cus in your windows directory. The settings 
stored are: View mode, Hide mode, Font, Tabs, and IconOnTop settings.



Store settings for file

Once you have the settings the way you like for the file that you are reading (the open file), you 
can store the settings by choosing this menu item. The settings are stored in a file with the same 
name and path name (see note below) but with the ".qfs" extension. Your text file is not 
modified.

Whenever QRead opens a file, it checks for the associated .qfs file. If one exists, QRead will 
read the stored settings from the .qfs file and update the settings. The settings stored are: View 
mode, Hide mode, Font, Tabs, and IconOnTop, and bookmark.

You can set up QRead to automatically create .qfs files on close or exit (by using the Entry/Exit 
menu item) but this menu item allows you to explicitly create a .qfs file.

Note: You can choose to have QRead create all .qfs files in your Windows directory, rather than 
in the same directory as the open file.    Remember that with this choice, files with the same name
in different directories will use the same .qfs file.    To use the Windows directory for .qfs file, 
you must edit your qread.ini file. Insert the following line:

UseWinDir=TRUE



Help on QRead

This menu item lets you use the Windows help program (with its hypertext features) to read the 
qread.hlp file.    The same information is also available in the file qrhelp.txt if you want to print 
the help info and read it at a less "hyper" pace.



How to use Help

This menu item takes you directly to the "how to" section of the Windows help program. You can
also get these instructions after you are in the help program by choosing its Help menu item.



About QRead

The About dialog box displays some info about QRead including the copyright message, the 
version number, and the name of the user licensed to use QRead.



How to do the "Drag-and-Drop"

QRead supports drag-and-drop as an alternate way to get the name of the target file (rather than 
using the Open or Open (continuous) commands from the File menu).

This means that you can "drag" a file name displayed in the File Manager window to the QRead 
icon (or window). When you "drop" the file name into QRead, the file will be immediately 
displayed. To try it out, use the following procedure. 

First, launch QRead. On the Options menu, enable the item "Keep icon on top." (A check mark 
will appear next to the item when it is enabled.) Then minimize QRead. Now launch File 
Manager. You can make the File Manager window as large as you want, even full screen, since 
the QRead icon will still be visible.

Now move the cursor over the name of a file. A text file would be a good choice, but any file will
do. Click (AND HOLD) the mouse button to select the file, then drag the cursor over on top of 
the QRead icon. Now "drop the file into Qread" by releasing the mouse button. The Qread 
window will be restored to its former size and the file you have selected will be displayed.

You can also drag-and-drop files into a (non-iconized) QRead window.



Qread Command Line

QRead will look for one argument on the command line. It will interpret the argument as a file 
name, and try to open the named file. This file specified on the command line takes precedence 
over the "open last file" setting. As always, when a file is opened, QRead will look for an 
associated ".qfs" file. If it finds one, QRead will load the appropriate environment. 



Windows Program Manager Tricks

You can create a program item for QRead in the Windows Program Manager by using the File 
menu, and the New menu item. If you want to create many specific program items for QRead, 
one for each file you typically read, here are my suggested steps. 

First, make a copy of your QRead item by using the File menu, and the Copy menu item. Then 
use File, Properties to change the description, command line and icon. Change the description to 
mention the file name. Change the command line to supply the file name (using the full path 
name) as an argument. Finally, change the icon to the open file icon (the one with the "writing" 
on the book).

When you click on one of these specific program items, QRead will start up and open the 
specified file. If there is an associated ".qfs" file, QRead will also load the appropriate 
environment.



Special Characters

In general, QRead treats all characters in the open file equally and displays them or prints them. 
However, some special characters are treated differently.

Qread uses the following control characters to control formatting of the display: Carriage Return 
(CR), Line Feed (LF), Tab (HT) and Form Feed (FF). These characters are NOT displayed; they 
are interpreted. Tabs are interpreted according to the settings shown in the Tabs dialog box, and 
the view setting. Encountering a Form Feed character causes a clear to the bottom of the window
when displaying the file on the screen, and causes a page to be ejected when printing.

Other low order characters (from 0x00 to 0x19) are displayed, unless the Hide low characters 
menu item is enabled.

High order characters (from 0x7F to 0xFF) are displayed, unless the Hide high characters menu 
item is enabled.

If you show these characters, but the display is not what you expected, you might try changing 
the font. Different fonts are designed to display different character sets. Most fonts used with 
Windows are designed for the ANSI character set, but some fonts (for example, Terminal) are 
designed for the PC/DOS/ASCII character set, also know as the OEM character set.



Keyboard Input

In addition to the accelerator keys shown in the menus, several other keys are monitored. The 
arrow keys, PageUp, PageDown, Home, End and SPACE bar are used to move through the file.

It is worth noting that the + and - keys can be used to pump up and deflate the font (except in the 
With adjusted type view).

If you want to delete the open file without using the mouse, you can do so quickly with the 
sequence: Delete, Enter.

The sequence: Ctrl+F8, Ctrl+F9, Ctrl+F10 is useful at the end of a reading session, since it will 
place the bookmark, save the settings (including the bookmark), and exit QRead.



What's new in this version

VERSION 1.0.1
      First release.

VERSION 1.1
    Added printing

VERSION 1.2
    Added drag and drop support
    Added Hide menu items - for low order and high order characters
    Added ReOpen menu item
    Added Home and End key response
    Added double click response in the Fonts dialog box
    Added response to FF (form feed) characters in the text file
    Added file wraparound feature to Find
    Added qread.ini option to use Windows directory for .qfs files
    Changed view mode menu check marks (to denote 1 of N choice)
    Changed "Copy page to clipboard" menu item to "Copy to clipboard"
    Fixed copy of blank lines in Copy to clipboard
    Fixed double paint on Open
    Fixed double paint on Find




